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Tutorial on CellML and OpenCOR 27
th

 May 2015 PJH 

This tutorial shows you how to install and run the OpenCOR software, and to author and edit CellML 
models1. We start by creating a simple model from scratch, saving it as a CellML file and running 
model simulations. We next try opening existing CellML models, both from a local directory and 
from the Physiome Model Repository. The various features of CellML2 and OpenCOR are then 
explained in the context of increasingly complex biological models. A simple first order ODE model 
and a nonlinear third order model are introduced. Ion channel gating models are used to introduce 
the way that CellML handles units, components and connections. More sophisticated potassium and 
sodium ion channel models are then described as models that can subsequently be imported into 
the Hodgkin-Huxley 1952 squid axon neural model using the CellML model import facility.   
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1. Installing and launching OpenCOR 

Download OpenCOR from www.opencor.ws. Versions are available for Windows, Mac and Linux. 
Create a shortcut to the executable (found in the bin directory) on your desktop and click on this to 
launch OpenCOR. A window will appear that looks like Figure 1(a).     

  
 (a) (b) 

Figure 1. (a) Default positioning of dockable windows. (b) An alternative configuration achieved by dragging 
and dropping the dockable windows. 

The central area is used to interact with files. By default, no files are open, hence the OpenCOR logo 
is shown instead. To the sides, there are dockable windows, which provide additional features. 
Those windows can be dragged and dropped to the top or bottom of the central area as shown in 
Figure 1(b) or they can be individually undocked or closed. All closed panels can be re-displayed by 
enabling them in the View menu, or by using the Tools menu Reset All option. Clicking on ‘CTRL’ & 
‘spacebar’ on the Windows version, removes (for less clutter) or restores these two side panels.  

                                                           
1
 For an overview and the background of CellML see www.cellml.org.   

2
 For details on the specifications of CellML1.0 see www.cellml.org/specifications/cellml_1.0. 

http://www.opencor.ws/
http://www.cellml.org/
http://www.cellml.org/specifications/cellml_1.0
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2. Creating and running a simple CellML model: editing and simulation 

In this example we create a simple CellML model from scratch and run it. The model is the Van der 
Pol oscillator3 defined by the second order equation  

   

   
  (    )

  

  
     

with initial conditions       
  

  
  . The parameter   controls the magnitude of the damping 

term. To create a CellML model we convert this to two first order equations4 by defining the velocity 
  

  
 as a new variable  : 

 
  

  
   

 
  

  
  (    )    

The initial conditions are now         .  

With the central pane in Editing mode (e.g. CellML Text View), under the File menu and New, click on 
CellML 1.1 File then type in the following lines of code:   

def model van_der_pol_model as 
    def comp main as 
         var t: dimensionless {init: 0}; 
         var x: dimensionless {init: -2}; 
         var y: dimensionless {init: 0}; 
         var mu: dimensionless {init: 1}; 

         ode(x,t)=y; 
         ode(y,t)=mu*(1{dimensionless}-sqr(x))*y-x; 
    enddef; 
enddef; 

Things to note5 are: (i) the closing semicolon at the end of each line (apart from the first two def 
statements that are opening a CellML construct); (ii) the need to indicate dimensions for each 
variable and constant (all dimensionless in this example – but more on dimensions later); (iii) the use 
of ode(x,t) to indicate a first order6 ODE in x and t, and (iv) the use of the convenient squaring 
function sqr(x) for   .  

A partial list of mathematical functions available for OpenCOR is:  

   sqr(x) √  sqrt(x)     ln(x)        log(x)    exp(x)    pow(x,a) 

     sin(x)      cos(x)      tan(x)      csc(x)      sec(x)      cot(x) 

       asin(x)        acos(x)        atan(x)        acsc(x)        asec(x)        acot(x) 

      sinh(x)       cosh(x)       tanh(x)       csch(x)       sech(x)       coth(x) 

        asinh(x)         acosh(x)         atanh(x)         acsch(x)         asech(x)         acoth(x) 

Table 1. The list of mathematical functions available for coding in OpenCOR. 

Positioning the cursor over either of the ODEs renders the maths in standard form above the code as 
shown in Figure 2(a). 
  

                                                           
3
 en.wikipedia.org/wiki/Van_der_Pol_oscillator 

4
 Note that gray boxes are used to indicate equations that are implemented directly in OpenCOR.  

5
 For more on the CellML Text view see opencor.ws/user/plugins/editing/CellMLTextView.html.   

6
 Note that a more elaborated version of this is ‘ode(x, t, 1{dimensionless})’ and a 2

nd
 order ODE can be 

specified as ‘ode(x, t, 2{dimensionless})’. 1
st

 order is assumed as the default. 

http://en.wikipedia.org/wiki/Van_der_Pol_oscillator
http://opencor.ws/user/plugins/editing/CellMLTextView.html
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Note that CellML is a declarative language (unlike say C, Fortran or Matlab, which are procedural 
languages) and the order of statements therefore does not affect the solution. For example, the 
order of the ODEs could equally well be  

 

The significance of this will become apparent later when we import several CellML models to create 
a composite model.    

                                   
 (a) (b) 

Figure 2. (a) Positioning the cursor over an equation (shown by the highlighted line) renders the 
maths. (b) Once the model has been saved, the RH tabs provide different views of the CellML code.  

Now save the code to a local folder using Save under the File menu (or ‘CTRL-S’) and choosing .cellml 
as the file format7. With the CellML model saved various views, accessed via the tabs on the right 
hand edge of the window, become available. One is the CellML Text view (the view used to enter the 
code above); another is the Raw CellML view that displays the way the model is stored (note that 
positioning the cursor over part of the code shows the maths in this view also); and another is the 
Raw view.      

With the equations and initial conditions defined, we are ready to run the model. To do this, click on 
the Simulation tab on the left hand edge of the window. You will see three main areas - at the left 
hand side of the window are the Simulation, Solvers, Graphs and Parameters panels, which are 
explained below. At the right hand side is the graphical output window, and running along the 
bottom of the window is a status area, where status messages are displayed.   

Simulation panel 
This area is used to set up the simulation settings. 

 Starting point - the value of the variable of integration (often time) at which the simulation 
will begin. Leave this at 0. 

 Ending point - the point at which the simulation will end. Set to 100. 
 Point interval - the interval between data points on the variable of integration. Set to 0.1. 

Just above the Simulation panel are controls for running the simulation. These are:  

Run ( ), Pause ( ), Reset parameters ( ), Clear simulation data ( ), Interval delay ( ), 
Add( )/Subtract( ) graphical output windows and Output solution to a CSV file ( ). 

For this model, we suggest that you create three graphical output windows using the + button.   

 

 

 

                                                           
7
 Note that ‘.cellml’ is not strictly required but is best practice. 

ode(y,t)=mu*(1{dimensionless}-sqr(x))*y-x; 
ode(x,t)=y;       
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Solvers panel  
This area is used to configure the solver that will run the simulation.     

 Name - this is used to set the solver algorithm. It will be set by default to be the most 
appropriate solver for the equations you are solving. OpenCOR will allow you to change this 
to another solver appropriate to the type of equations you are solving if you choose to. For 
example, CVODE for ODE (ordinary differential equation) problems, IDA for DAE (differential 
algebraic equation) problems, KINSOL for NLA (non-linear algebraic) problems8. 

 Other parameters for the chosen solver – e.g. Maximum step, Maximum number of steps, 
and Tolerance settings for CVODE and IDA. For more information on the solver parameters, 
please refer to the documentation for the particular solver. 

Note: these can all be left at their default values for our simple demo problem9. 

Graphs panel 
This shows what parameters are being plotted once these have been defined in the Parameters 
panel. These can be selected/deselected by clicking in the box next to a parameter.  

Parameters panel 
This panel lists all the model parameters, and allows you to select one or more to plot against the 
variable of integration or another parameter in the graphical output windows. OpenCOR supports 
graphing of any parameter against any other. All variables from the model are listed here, arranged 
by the components in which they appear, and in alphabetical order. Parameters are displayed with 
their variable name, their value, and their units. The icons alongside them have the following 
meanings: 

  Editable constant 

 Computed constant 

 Editable state 

 Rate  

 Algebraic 
 

Right clicking on a parameter provides the options for displaying that parameter in the currently 
selected graphical output window. With the cursor highlighting the top graphical output window (a 
blue line appears next to it), select x then Plot Against Variable of Integration – in this case t - in 
order to plot x(t).  

Now move the cursor to the second graphical output window and select y then t to plot y(t).  

Finally select the bottom graphical output window select y and select Plot Against then Main then x 
to plot y(x). 

Now Click on the Run control. You will see a progress bar running along the bottom of the status 
window. Status messages about the successful simulation will be displayed. Use the interval delay 
wheel to slow down the plotting. Figure 3 shows the results.  

                                                           
8
 Other solvers include forward Euler, Heun and Runga-Kutta solvers (RK2 and RK4). 

9
 Note that a model that requires a stimulus protocol should have the maximum step value of the CVODE 

solver set to the length of the stimulus. 
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Figure 3. Graphical output from OpenCOR. The top window is x(t), the middle is y(t) and the bottom is y(x). 

 

To obtain numerical values for all variables (i.e. x(t) and y(t)), click on the CSV file button ( ). You 
will be asked to enter a filename and type (use .csv). Opening this file (e.g. with Microsoft Excel) 
provides access to the numerical values. Other output types (e.g. BiosignalML) will be available 
shortly.   
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3. Opening an existing CellML file  

Go to the File menu and select Open.... Browse to the folder that contains your existing models and 
select one. Note that this brings up a new tabbed window and you can have any number of CellML 
models open at the same time in order to quickly move between them. A model can be removed 
from this list by clicking on  next to the CellML model name.  

You can also access models from the left hand panel in Figure 1(a). If this panel is not currently 
visible, use ‘CTRL-spacebar’ to make it reappear. Models can then be accessed from any one of the 
three subdivisions of this panel – File Browser, CellML Model Repository or File Organiser. For a file 
under File Browser or File Organiser, either double-click it or ‘drag&drop’ it over the central 
workspace to open that model. Clicking on a model in the CellML Model Repository (e.g. Chen, Popel, 
2007) opens a new browser window with that model (see top of Figure 4 below). In the right hand 
corner you will see a reference to the workspace. Clicking on the link (i.e. ‘Chen, Popel, 2007’) opens 
the middle figure below. To open this CellML model in OpenCOR, copy the URI into the text box that 
appears under Open Remote… in the File menu in OpenCOR.  

 

 

 

 

 

 

 

 

     

     

Figure 4. Browser windows (top and middle) opened from within OpenCOR and showing a model in the CellML 
model repository. The red arrow points to the URI for that model. Copying this and inserting it into the text 
box that appears under Open Remote… in the File menu (bottom), opens the model in OpenCOR.  

Obtain URI 

Enter URI 
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4. A simple first order ODE 

The simplest example of a first order ODE is  

  
  

  
        

with the solution 

    ( )  
 

 
 . ( )  

 

 
/      ,  

where  ( ), the value of  ( ) at    , is the initial condition and as    ,  ( | )   ( )  
 

 
  

(see Figure 5). Note that     
 

 
  is called the time constant of the exponential decay, and that 

   ( )  
 

 
 . ( )  

 

 
/     . 

At      ,  ( ) has therefore fallen to 
 

 
 (or about 37%) of the difference between the initial ( ( )) 

and final steady state (  ( )) values.  

Choosing parameters         and  ( )   , the CellML text for this model is  
 

def model first_order_model as 
   def comp main as 
      var t: dimensionless {init: 0}; 
      var y: dimensionless {init: 5}; 
      var a: dimensionless {init: 1}; 
      var b: dimensionless {init: 2}; 

      ode(y,t)=-a*y+b; 
   enddef; 
enddef; 

The solution by OpenCOR is shown in Figure 6(a) for these parameters and in Figure 6(b) for 
parameters         and  ( )   . Note the simulation panel with Ending point=10, Point 
interval=0.1) 

    
    (a) (b) 

Figure 6. OpenCOR output  ( ) for the simple ODE model with parameters (a)          and  ( )   , 
and (b)         and  ( )   . The red arrow indicates the point at which the trace reaches the time 

constant   (    or ≈37% of the difference between the initial and final solution values). Note that the 

parameters on the left have been reset to their initial values for this figure – normally they would be at their 
final solution values. 

These two solutions have the same exponential time constant (  
 

 
  ) but different initial and 

final (steady state) values.   

𝝉  𝟏 

𝝉  𝟏 

exponential  
decay  

Figure 5.Solution of 1
st

 order equation. 
 𝑡 

𝑦(𝑡) 

𝑏

𝑎
 

𝑦( ) 
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5. A Lorenz attractor 

An example of a third order ODE system (i.e. three 1st order equations) is the Lorenz attractor10.  

This has three equations:   

  
  

  
  (   ) 

 
  

  
  (   )    

 
  

  
       

where     and   are parameters. 

The CellML text code entered for  
these equations is shown in Figure 7  
with parameters 

    ,     ,       = 2.66667  

and initial conditions  

 ( )   ( )   ( )  1.  

Solutions for  ( ),  ( ) and  ( ), corresponding to the time integration parameters shown on the 
LHS, are shown in Figure 8. Note that this is an example of a ‘chaotic’ system of equations because 
small changes in the initial conditions lead to quite different solution paths.   

 

 Figure 8. Solutions of the Lorenz equations. Note that the parameters on the left have been reset to 
their initial values for this figure – normally they would be at their final solution values.  

This example illustrates the value of OpenCOR’s ability to plot solution variables as they are 
computed. Use the ‘simulation delay’ wheel to slow down the plotting by a factor of about 5000 – in 
order to follow the solution trajectory as it spirals in ever widening trajectories around the left hand 
‘attractor’ before reaching a bifurcation point that sends it off to the right hand attractor.  

                                                           
10

 http://en.wikipedia.org/wiki/Lorenz_system; https://www.math.auckland.ac.nz/~hinke/crochet/     

𝒙(𝒕) 

𝒚(𝒙) 

𝒛(𝒙) 

Figure 7. CellML Text View code for the Lorentz equations. 

http://en.wikipedia.org/wiki/Lorenz_system
https://www.math.auckland.ac.nz/~hinke/crochet/
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               (a)                          (b) 
Figure 10. Transient behaviour for one 
gate (left) and 𝛾 gates in series (right). 

1 

𝑡 

𝑦 

𝑡 

𝑦𝛾 

0 

6. A model of ion channel gating and current: Introducing CellML units 

A good example of a model based on a first order equation is the one used by Hodgkin and Huxley 
[8] to describe the gating behaviour of an ion channel (see also next three sections). To describe the 
time dependent transition between the closed and open states of the channel, Hodgkin and Huxley 
introduced the idea of channel gates that control the passage of  ions through a membrane ion 
channel. If the fraction of gates that are open is y, the 
fraction of gates that are closed is 1-y, and a first order ODE 
can be used to describe the transition between the two 
states (see Figure 9):  

 
  

  
   (   )       

where   is the opening rate and    is the closing rate.   

The solution to this ODE is  

   
  

     
    (     )  

The constant   can be interpreted as    ( )  
  

     
 as in 

the previous example and, with  ( )    (i.e. all gates initially 
shut), the solution looks like Figure 10(a).   

The experimental data obtained by Hodgkin and Huxley for the squid axon, however, indicated that 
the initial current flow began more slowly (Figure 10(b)) and they modelled this by assuming that the 
ion channel had   gates in series so that conduction would only occur when all gates were at least 
partially open. Since   is the probability of a gate being open,    is the probability of all   gates 
being open (since they are assumed to be independent) and the current through the channel is  

      ̅ 
     ̅ (    ) 

where   ̅   ̅ (    ), the steady state current through the open 

gate, is governed by Ohm’s law. i.e. the current is equal to the 
channel conductance  ̅  times the driving potential, which in this 

case is the difference between the membrane potential   
(referenced to the external potential) and the Nernst equilibrium 
potential for that ion,    (see Figure 11).  

We can represent this in OpenCOR with a simple extension of the 1st order ODE model, but in 
developing this model we will also demonstrate the way in which CellML deals with units.    

There are seven base physical quantities defined by the Système International d’Unités (SI)11. These 
are (with their SI units): length (meter or m), time (second or s), amount of substance (mole), 
temperature (K), mass (kilogram or kg), current (amp or A) and luminous intensity (candela). All 
other units are derived from these seven. Additional derived units that CellML defines intrinsically 
are: Hz (s−1); Newton, N (kg⋅m⋅s−2); Joule, J (N.m); Pascal, Pa (N.m-2); Watt, W (J.s−1); Volt, V (W.A−1); 
Siemen, S (A.V−1); Ohm,   (V.A−1); Coulomb, C (s.A); Farad, F (C.V−1); Weber, Wb (V.s); Henry, H 
(Wb.A−1). Multiples and fractions of these are defined as follows: 

Multiples 

Prefix  deca hecto kilo mega giga tera peta exa zetta yotta 

Symbol  da h k M G T P E Z Y 

Factor 10
0
 10

1
 10

2
 10

3
 10

6
 10

9
 10

12
 10

15
 10

18
 10

21
 10

24
 

Fractions 

Prefix  deci centi milli micro nano pico femto atto zepto yocto 

Symbol  d c m μ n p f a z y 

Factor 10
0
 10

−1
 10

−2
 10

−3
 10

−6
 10

−9
 10

−12
 10

−15
 10

−18
 10

−21
 10

−24
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 http://en.wikipedia.org/wiki/International_System_of_Units   

𝛼𝑦 

Figure 9. Ion channel gating kinetics. 𝑦 
is the fraction of gates in the open state. 
𝛼𝑦 and 𝛽𝑦 are the rate constants for 

opening and closing, respectively. 

𝛽𝑦 
𝑦 

  𝑦 

𝒊�̅� 

𝑬𝑦 
𝑽 

𝒊�̅�  𝑔 𝑦(𝑽  𝑬𝑦) 

Figure 11. Open channel linear 
current-voltage relation. 

http://en.wikipedia.org/wiki/International_System_of_Units
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Units for this model, with multiples and fractions, are illustrated in the following CellML text code:  

    def model first_order_model as 
       def unit millisec as 
           unit second {pref: milli}; 
       enddef; 

       def unit per_millisec as 
           unit second {pref: milli, expo: -1}; 
        enddef; 

       def unit millivolt as 
           unit volt {pref: milli}; 
       enddef; 

       def unit microA_per_cm2 as 
           unit ampere {pref: micro}; 
           unit metre {pref: centi, expo: -2}; 
       enddef; 

       def unit milliS_per_cm2 as 
           unit siemens {pref: milli}; 
           unit metre {pref: centi, expo: -2}; 
       enddef; 

       def comp ion_channel as 
           var V: millivolt {init: 0}; 
           var t: millisec {init: 0}; 
           var y: dimensionless {init: 0}; 
           var E_y: millivolt {init: -85}; 
           var i_y: microA_per_cm2; 
           var g_y: milliS_per_cm2 {init: 36}; 
           var gamma: dimensionless {init: 4}; 
           var alpha_y: per_millisec {init: 1}; 
           var beta_y: per_millisec {init: 2}; 

           ode(y, t) = alpha_y*(1{dimensionless}-y)-beta_y*y; 

           i_y = g_y*pow(y, gamma)*(V-E_y); 
        enddef; 
    enddef; 

The solution of these equations for the parameters indicated above is illustrated in Figure 12. 

 

Figure 12. The behaviour of an ion channel with     gates transitioning from the closed to the open state at 
a membrane voltage    . The opening and closing rate constants are      ms

-1
 and      ms

-1
. The ion 

channel has an open conductance of  ̅     mS.cm
-2

 and an equilibrium potential of        mV. The 

upper transient is the response  ( ) for each gate and the lower trace is the current through the channel.  

  

Define units and initial conditions for variables 

Define units for time as millisecs 

Define per_millisec units 

Define units for voltage as millivolts 

Define units for current as microAmps per cm
2
 

Define units for conductance as milliSiemens per cm
2
 

Define ODE for gating variable y 
Define channel current 
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7. A model of the potassium channel: Introducing CellML components and connections  

We now deal specifically with the application of the previous model to the Hodgkin and Huxley (HH) 
potassium channel. Following the convention introduced by Hodgkin and Huxley, the gating variable 
for the potassium channel is   and the number of gates in series is    , therefore 

      ̅ 
     ̅ (    ) 

where  ̅   36 mS.cm-2, and with intra- and extra-cellular concentrations ,  - = 90mM and ,  - = 
3mM, respectively, the Nernst potential for the potassium channel is 

     
  

 
  

,  - 
,  - 

      
 

  
      .  

Note that this is called the equilibrium potential since it is the potential across the cell membrane 
when the channel is open but no current is flowing because the electrostatic driving force from the 
potential (voltage) difference between internal and external ion charges is exactly matched by the 
osmotic driving force from the ion concentration difference.    ̅  is the channel conductance.  

The gating kinetics are described (as before) by 

 
  

  
   (   )          

with time constant    
 

     
.  

The main difference from the gating model in our previous 
example is that Hodgkin and Huxley found it necessary to 
make the rate constants functions of the membrane 
potential   (see Figure 13) as follows12:  

    
     (    )

 
 (    )

    

;              
 (    )

   . 

Note that under steady state conditions when     and  
  

  
  ,  |       

  

     
 . 

These equations are captured with OpenCOR CellML text (together with the previous unit 
definitions) on the next page. But first we need to explain some further CellML concepts. 

We introduced CellML units above. We now need to 
introduce two more CellML constructs: components and 
connections (mappings between components).  For 
completeness we also show two other constructs in Figure 
14 that will be used later: imports and groups.13 

Defining components serves two purposes: it preserves a 
modular structure for CellML models, and allows these 
component modules to be imported into other models, as 
we will illustrate later.  For the potassium channel model 
we define components representing (i) the environment, 
(ii) the potassium channel conductivity, and (iii) the 
dynamics of the n-gate. 

Since certain variables (t, V and n) are shared between 
components, we need to also define the component maps 
as indicated in the CellML text view on the next page.  

                                                           
12

 The original expression in the HH paper used    
    (    )

 
(    )
    

 and           
 

   , where   is defined 

relative to the resting potential (-75mV) with +ve   corresponding to +ve inward current and    (    ).  
13

 See also [1,2]. 

CellML 

model 

component 

variable 

math 

group 

relationshipRef 

componentRef 

imported units 

imported component 

import 

units 

unit 

connection 

mapComponent 

mapVariable 

Figure 14. Key entities in a CellML model. 

1 
𝛼𝑛 𝛽𝑛 

𝑉 

Figure 13. Voltage dependence of rate 

constants 𝛼𝑛 and 𝛽𝑛 and time constant 𝜏𝑛 

𝜏𝑛 
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The CellML text code for the potassium ion channel model is as follows14: 

def model potassium_ion_channel as 

    def unit millisec as 
        unit second {pref: milli}; 
    enddef; 

    def unit per_millisec as 
        unit second {pref: milli, expo: -1}; 
    enddef; 

    def unit millivolt as 
        unit volt {pref: milli}; 
    enddef; 

    def unit microA_per_cm2 as 
        unit ampere {pref: micro}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 

    def unit milliS_per_cm2 as 
        unit siemens {pref: milli}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 

   def comp environment as 
        var V: millivolt {init: -85, pub: out}; 
        var t: millisec {pub: out}; 
        V = sel 
             case (t > 5 {millisec}) and (t < 15 {millisec}): 
                -20.0 {millivolt}; 
             otherwise: 
                -85.0 {millivolt};  
       endsel; 
 enddef; 

    def comp potassium_channel as  
        var V: millivolt {pub: in};         
        var n: dimensionless {pub: in}; 
        var i_K: microA_per_cm2 {pub: out}; 
        var g_K: milliS_per_cm2 {init: 36}; 
        var E_K: millivolt {init: 36}; 

        i_K = g_K*pow(n, 4{dimensionless})*(V-E_K); 
    enddef; 

    def comp potassium_channel_n_gate as 
        var V: millivolt {pub: in}; 
        var t: millisec {pub: in}; 
        var n: dimensionless {init: 0.325, pub: out}; 
        var alpha_n: per_millisec; 
        var beta_n: per_millisec; 

        alpha_n = 0.01{per_millivolt_millisec}*(V+10{millivolt}) 
       /(exp((V+10{millivolt})/10{millivolt})-1{dimensionless}); 
        beta_n = 0.125{per_millisec}*exp(V/80{millivolt}); 

        ode(n, t) = alpha_n*(1{dimensionless}-n)-beta_n*n;  
     enddef; 

     def map between potassium_channel and environment for 
        vars V and V; 
     enddef; 
     def map between potassium_channel and potassium_channel_n_gate for 
         vars n and n; 
     enddef; 

     def map between potassium_channel_n_gate and environment for 
        vars V and V; 
        vars t and t; 
     enddef; 

enddef; 

  

                                                           
14

 From here on we use a coloured background to identify code blocks that relate to a particular CellML 
construct: units, components, mappings and later encapsulation groups and imports.   

Define units 

Define component ‘environment’ 

Define component ‘potassium channel’ 

Define component ‘potassium channel n gate’ 

Define mappings between  
components for variables  
that are shared between  
these components 

Define  
voltage step 
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Note that one other feature has been added: the event control select case which indicates that the 
voltage is specified to jump from -85mV to -20mV at t=5ms then back to -85mV at t=15ms. This is 
only used here in order to test the K channel model; when the potassium_channel component is 
later imported into a neuron model, the environment component is not imported. 

Note also the use of *      + and *       + to indicate which variables are either supplied as inputs 
to a component or produced as outputs from a component15. Any variables not labelled as in or out 
are local variables or parameters defined and used only within that component. Public (and private) 
interfaces are discussed in more detail in the next section. 

We now use OpenCOR to solve the 
equations for the potassium channel under 
a voltage step condition in which the 
membrane voltage is clamped initially at  
-85mV and then stepped up to higher 
voltage for 10ms before being returned to  
-85mV. At a membrane voltage of -85mV, 
the steady state value of the n gate is 

   
  

     
        Three cases are 

shown in Figure 15: steps to -20mV (top 
set), 0mV (middle set) and +20mV (bottom 
set). The voltage traces are shown at the 
top of each set, the n-gate response (by 
opening from its resting value and then 
plateauing at the peak step voltage before 
closing again as the voltage is stepped back 
to rest) are shown in the middle of each set, 
and the channel conductance    ̅  is 
shown as the bottom trace in each set. Note 
that the gate closing behaviour is slower 
than the opening behaviour in all cases and 
that the opening behaviour is faster as the 
voltage is stepped to higher values since 

  
 

     
 reduces with increasing V  

(see Figure 13).   

Note that this potassium channel model will 
be used later, along with a sodium channel 
model and a leakage channel model, to 
form the Hodgkin-Huxley neuron model, 
where the membrane ion channel current 
flows are coupled to the equations 
governing current flow along the axon to 
generate an action potential.  
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 Note that a later version of CellML will remove the terms in and out since it is now thought that the direction 
of information flow should not be constrained.   

𝑽(𝒕) 

𝒏(𝒕) 

𝒈𝑲(𝒕) 

-20V 

𝑽(𝒕) 

𝒏(𝒕) 

𝒈𝑲(𝒕) 

0V 

𝑽(𝒕) 

𝒏(𝒕) 

𝒈𝑲(𝒕) 

20V 

Figure 15. Transient responses to voltage steps. 
See text for explanation and analysis.  
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8. A model of the sodium channel: Introducing CellML encapsulation and interfaces 

The HH sodium channel has two types of gate, an   gate (of which there are 3) that is initially closed 
(   ) before activating and inactivating back to the closed state, and an   gate that is initially open 
(   ) before activating and inactivating back to the open state. The short period when both types 
of gate are open allows a brief window current to pass through the channel. Therefore,  

       ̅  
        ̅  (     ) 

where  ̅    120 mS.cm-2, and with ,   - = 30mM and ,   - = 140mM, the Nernst potential for 
the sodium channel is  

     
  

 
  
,   - 
,   - 

      
   

  
     . 

The gating kinetics are described by 

 
  

  
   (   )      ;   

  

  
   (   )       

where the voltage dependence of these four rate constants is determined experimentally to be 

    
    (    )

 
 (    )

    

;          
 (    )

  ;            
 (    )

  ;       
 

 
 (    )

    

.16 

Before we construct a CellML model of the sodium channel, we first introduce some further CellML 
concepts that help deal with the complexity of biological models: first the use of encapsulation 
groups and public and private interfaces to control the visibility of information in modular CellML 
components. To understand encapsulation, it is useful to use the terms ‘parent’, ‘child’ and ‘sibling’. 

We define the CellML components sodium_channel_m_gate 
and sodium_channel_h_gate below. Each of these components 
has its own equations (voltage-dependent gates and first 
order gate kinetics) but they are both parts of one protein – 
the sodium channel – and it is useful to group them into one 
sodium_channel component as shown on the right: 

We can then talk about the sodium channel as the parent of two children: the m gate and the h gate, 
which are therefore siblings. A private interface allows a parent to talk to its children and a public 
interface allows siblings to talk among themselves and to their parents (see Figure 16).  

 
 

 
 
 
 
 
 
 
 
 
 

 

Figure 16. The children talk to each other as siblings, and to their parents, via public interfaces. But the outside 
world can only talk to children through their parents via a private interface.  Note that the siblings m_gate and 
h_gate could talk via a public interface but only if a mapping is established between them (not needed here).  
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 The HH paper used    
   (    )

 
(    )
    

;        
 

  ;          
 

  ;     
 

 
(    )
    

   (see footnote on p10). 

def group as encapsulation for 
     comp sodium_channel incl 
          comp sodium_channel_m_gate; 
          comp sodium_channel_h_gate; 
    endcomp; 
enddef; 
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Parents communicate with 
children via private interface 

Children communicate with 
parents via public interface 

sodium_channel 

m_gate 

h_gate 

m: {priv: in} & {pub: out} 

h: {priv: in} & {pub: out} 

V, t: {priv: out} & {pub: in} 

environment 

V, t:  
{pub: out} 
{pub: in} 

i_Na:  
{pub: in} 

{pub: out} 
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The OpenCOR CellML text for the HH sodium ion channel is given below.  

def model sodium_ion_channel as 

    def unit millisec as 
        unit second {pref: milli}; 
    enddef; 
    def unit per_millisec as 
        unit second {pref: milli, expo: -1}; 
    enddef; 
    def unit millivolt as 
        unit volt {pref: milli}; 
    enddef; 
    def unit per_millivolt as 
        unit millivolt {expo: -1}; 
    enddef; 
    def unit per_millivolt_millisec as 
        unit per_millivolt; 
        unit per_millisec; 
    enddef; 
    def unit microA_per_cm2 as 
        unit ampere {pref: micro}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 
    def unit milliS_per_cm2 as 
        unit siemens {pref: milli}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 

    def comp environment as 
        var V: millivolt {pub: out}; 
        var t: millisec {pub: out}; 
        V = sel 
               case (t > 5 {millisec}) and (t < 15 {millisec}): 
                 -20.0 {millivolt}; 
               otherwise: 
                 -85.0 {millivolt};  
         endsel; 
    enddef;         

    def group as encapsulation for 
         comp sodium_channel incl 
            comp sodium_channel_m_gate;  
            comp sodium_channel_h_gate;  
        endcomp; 
    enddef; 

   def comp sodium_channel as 
        var V: millivolt {pub: in, priv: out}; 
        var t: millisec {pub: in, priv: out }; 
        var m: dimensionless {priv: in}; 
        var h: dimensionless {priv: in}; 
        var g_Na: milliS_per_cm2 {init: 120}; 
        var E_Na: millivolt {init: 35}; 
        var i_Na: microA_per_cm2 {pub: out}; 

        i_Na = g_Na*pow(m, 3{dimensionless})*h*(V-E_Na); 
    enddef; 

    def comp sodium_channel_m_gate as 
        var V: millivolt {pub: in}; 
        var t: millisec {pub: in}; 
        var alpha_m: per_millisec;  
        var beta_m: per_millisec; 
        var m: dimensionless {init: 0.05, pub: out}; 

        alpha_m = 0.1{per_millivolt_millisec}*(V+25{millivolt}) 
   /(exp((V+25{millivolt})/10{millivolt})-1{dimensionless}); 
        beta_m = 4{per_millisec}*exp(V/18{millivolt}); 

        ode(m, t) = alpha_m*(1{dimensionless}-m)-beta_m*m; 
    enddef; 

 

 

 

 

Define  
voltage step 

Define units 

Define component  
‘environment’ 

Define component  
‘sodium channel m gate’ 

Define component  
‘sodium channel’ 

Define encapsulation  
of m_gate and h_gate 
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    def comp sodium_channel_h_gate as 
        var V: millivolt {pub: in}; 
        var t: millisec {pub: in}; 
        var alpha_h: per_millisec;  
        var beta_h: per_millisec;  
        var h: dimensionless {init: 0.6, pub: out}; 

        alpha_h = 0.07{per_millisec}*exp(V/20{millivolt}); 
        beta_h = 1{per_millisec}/(exp((V+30{millivolt})/10{millivolt})+1{dimensionless}); 

        ode(h, t) = alpha_h*(1{dimensionless}-h)-beta_h*h; 
    enddef; 

    def map between sodium_channel and environment for 
        vars V and V; 
        vars t and t;  
    enddef; 
    def map between sodium_channel and sodium_channel_m_gate for 
        vars V and V; 
        vars t and t;  
        vars m and m; 
    enddef; 
    def map between sodium_channel and sodium_channel_h_gate for 
        vars V and V; 
        vars t and t;  
        vars h and h; 
    enddef; 

enddef; 

 

The results of the OpenCOR computation are shown in Figure 17 with plots of  ( ),  ( ),  ( ), 
   ( ) and    ( ) for voltage steps from -85mV to -20mV (top set), -85mV to 0mV (middle set) and  
-85mV to 20mV (bottom set). There are several things to note:  

(i) The kinetics of the m-gate are much faster than the h-gate.  
(ii) The sodium channel conductance rises (activates) and then falls (inactivates) under a positive 

voltage step from rest since the three m-gates turn on but the h-gate turns off and the 
conductance is a product of these. Compare this with the potassium channel conductance 
shown in Figure 14 which is only reduced back to zero by stepping the voltage back to its 
resting value – i.e. deactivating it.  

(iii) The only time current     flows through the sodium channel is during the brief period when 
the m-gate is rapidly opening and the much slower h-gate is beginning to close. A small 
current flows during the reverse voltage step but this is at a time when the h-gate is now 
firmly off so the magnitude is very small.   

(iv) The large sodium current     is an inward current and hence negative.  

  

Define component  
‘sodium channel h gate’ 

Define mappings between  
components for variables that are 
shared between these components 
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                Figure 17. The kinetics of the sodium channel gates. See text for discussion. 
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9. A model of the nerve action potential: Introducing CellML imports 

Here we describe the first (and most famous) model of nerve fibre electrophysiology based on the 
membrane ion channels that we have discussed in the last two sections. This is the work by Alan 
Hodgkin and Andrew Huxley in 195217 that won them (together with John Eccles) the 1963 Noble 
prize in Physiology or Medicine for "their discoveries concerning the ionic mechanisms involved in 
excitation and inhibition in the peripheral and central portions of the nerve cell membrane". 

Cable equation 
The cable equation was developed in 189018 to predict the degradation of an electrical signal passing 
along the transatlantic cable. It is derived as follows:  

If the voltage is raised at the left hand end of the cable (shown 
by the deep red in Figure 18), a current    (A) will flow that 

depends on the voltage gradient, given by  
  

  
 (V.m-1) and the 

resistance    (.m-1), Ohm’s law gives   
  

  
      . But if the 

cable leaks current    (A.m-1) per unit length of cable, conservation of current gives  
   

  
    and 

therefore, substituting for    ,  
 

  
. 

 

  

  

  
/     . There are two sources of membrane current    , 

one associated with the capacitance    (        ) of the membrane,   
  

  
, and one associated 

with holes or channels in the membrane,       . Inserting these into the RHS gives  

 
 

  
. 

 

  

  

  
/       

  

  
         

Rearranging gives the cable equation (for constant   ): 

   
  

  
  

 

  

   

   
          

where all terms represent current density (current per membrane area) and have units of       . 

Action potentials 
The cable equation can be used to model the propagation of an 
action potential along a neuron or any other excitable cell. The 
‘leak’ current is associated primarily with the inward movement 
of sodium ions through the membrane ‘sodium channel’, giving 
the inward membrane current    , and the outward movement 
of potassium ions through a membrane ‘potassium channel’, 
giving the outward current    (see Figure 19). A further small leak current      (    ) 
associated with chloride and other ions is also included.  

When the membrane potential   rises 
due to axial current flow, the Na 
channels open and the K channels close, 
such that the membrane potential 
moves towards the Nernst potential for 
sodium. The subsequent decline of the 
Na channel conductance and the 
increasing K channel conductance as 
the voltage drops rapidly repolarises 
the membrane to its resting potential of 
-85mV (see Figure 20).  
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 Hodgkin, A.L. and Huxley, A.F. A quantitative description of membrane current and its application to 
conduction and excitation in nerve. Journal of Physiology, 117, 500-544, 1952. PubMed ID: 12991237 
18

 http://en.wikipedia.org/wiki/Cable_theory 

Figure 18. Current flow in a leaky cable. 
equation. 

𝑖𝑚 

𝑖𝑎 𝑉 𝑥 

Figure 19. Current flow in a neuron. 
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Figure 20. Current-voltage trajectory during an action potential. 

Injection of outward current pulse  
pushes V to a threshold where Na channels 
open to allow a large inward (-ve) current  

I(V) for open K channel I(V) for open Na channel 

http://www.ncbi.nlm.nih.gov/entrez/query.fcgi?db=pubmed&cmd=Retrieve&dopt=AbstractPlus&list_uids=12991237&query_hl=1&itool=pubmed_docsum


 
 

19 
 

If we neglect the term ( 
 

  

   

   
)  (the rate of change of axial current along the cable), we can obtain 

the membrane potential   by integrating the first order ODE, 

  

  
  (          )   . 

Figure 21. A schematic cell diagram describing the current flows across the 
cell bilipid membrane that are captured in the Hodgkin-Huxley model. The 
membrane ion channels are a sodium (Na

+
) channel, a potassium (K

+
) 

channel, and a leakage (L) channel (for chloride and other ions) through 
which the currents INa, IK and IL flow, respectively. 

 
We use this example to demonstrate the importing feature of CellML. CellML imports are used to 
bring a previously defined CellML model of a component into the new model (in this case the Na and 
K channel19 components defined in the previous two sections, together with a leakage ion channel 
model specified below). Note that importing a component brings the children components with it 
along with their connections and units, but it does not bring the siblings of that component with it. 

To establish a CellML model of the HH equations we first lay out the model components with their 
public and private interfaces (Figure 22).   

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 22. Overall structure of the HH CellML model showing the encapsulation hierarchy (purple), the CellML 
model imports (blue) and the other key parts (units, components & mappings) of the top level CellML model.   

The HH model is the top level model. The CellML text code for the potassium_ion_channel model, 
leakage_channel model  and HH model are given on the next two pages (the sodium_ion_channel is 
unchanged from the previous section). 
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 Note that we have updated the K channel model to include the encapsulation of the n-gate into the 
potassium channel component – see p19.  
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def model potassium_ion_channel as 

    def unit millisec as 
        unit second {pref: milli}; 
    enddef; 
    def unit per_millisec as 
        unit second {pref: milli, expo: -1}; 
    enddef; 
    def unit millivolt as 
        unit volt {pref: milli}; 
    enddef; 
    def unit per_millivolt as 
        unit millivolt {expo: -1}; 
    enddef; 
    def unit per_millivolt_millisec as 
        unit per_millivolt; 
        unit per_millisec; 
    enddef; 
    def unit microA_per_cm2 as 
        unit ampere {pref: micro}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 
    def unit milliS_per_cm2 as 
        unit siemens {pref: milli}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 
 
    def comp environment as 
        var V: millivolt {init: 0, pub: out}; 
        var t: millisec {pub: out}; 
    enddef; 
 
    def group as encapsulation for 
        comp potassium_channel incl 
            comp potassium_channel_n_gate;  
        endcomp; 
    enddef; 
 
    def comp potassium_channel as 
        var V: millivolt {pub: in, priv: out}; 
        var t: millisec {pub: in, priv: out}; 
        var n: dimensionless {priv: in}; 
        var i_K: microA_per_cm2 {pub: out}; 
        var g_K: milliS_per_cm2 {init: 36}; 
        var E_K: millivolt {init: -85}; 
        i_K = g_K*pow(n, 4{dimensionless})*(V-E_K); 
    enddef; 
 
    def comp potassium_channel_n_gate as 
        var V: millivolt {pub: in}; 
        var t: millisec {pub: in}; 
        var alpha_n: per_millisec; 
        var beta_n: per_millisec; 
        var n: dimensionless {init: 0.325, pub: out}; 
        alpha_n = 0.01{per_millivolt_millisec}*(V+10{millivolt}) 
            /(exp((V+10{millivolt})/10{millivolt})-1{dimensionless}); 
        beta_n = 0.125{per_millisec}*exp(V/80{millivolt}); 
        ode(n, t) = alpha_n*(1{dimensionless}-n)-beta_n*n; 
    enddef; 
 
    def map between potassium_channel and environment for 
        vars V and V;  
        vars t and t; 
    enddef; 
    def map between  
             potassium_channel and potassium_channel_n_gate for 
        vars V and V; 
        vars t and t; 
        vars n and n; 
    enddef; 

enddef;

def model leakage_ion_channel as 
    def unit millisec as 
        unit second {pref: milli}; 
    enddef; 
    def unit millivolt as 
        unit volt {pref: milli}; 
    enddef;  
    def unit per_millivolt as 
        unit millivolt {expo: -1}; 
    enddef; 
    def unit microA_per_cm2 as 
        unit ampere {pref: micro}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 
    def unit milliS_per_cm2 as 
        unit siemens {pref: milli}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 
 
    def comp environment as 
         var V: millivolt {init: 0, pub: out};       
         var t: millisec {pub: out}; 
    enddef; 
     
    def map between leakage_channel and environment for 
        vars V and V;  
    enddef; 
 
    def comp leakage_channel as 
        var V: millivolt {pub: in}; 
        var i_L: microA_per_cm2 {pub: out}; 
        var g_L: milliS_per_cm2 {init: 0.3}; 
        var E_L: millivolt {init: -54.4}; 
        i_L = g_L*(V-E_L); 
    enddef; 

enddef; 
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def model HH as 

    def import using "sodium_ion_channel.cellml" for 
        comp Na_channel using comp sodium_channel; 
    enddef; 
    def import using "potassium_ion_channel.cellml" for 
        comp K_channel using comp potassium_channel; 
    enddef; 
    def import using "leakage_ion_channel.cellml" for 
        comp L_channel using comp leakage_channel; 
    enddef; 

    def unit millisec as 
        unit second {pref: milli}; 
    enddef; 
    def unit millivolt as 
        unit volt {pref: milli}; 
    enddef; 
    def unit microA_per_cm2 as 
        unit ampere {pref: micro}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 
    def unit microF_per_cm2 as 
        unit farad {pref: micro}; 
        unit metre {pref: centi, expo: -2}; 
    enddef; 

    def group as encapsulation for 
        comp membrane incl 
            comp Na_channel; 
            comp K_channel; 
            comp L_channel; 
        endcomp;  
    enddef;  

    def comp environment as 
        var V: millivolt {init: -85, pub: out}; 
       var t: millisec {pub: out}; 
    enddef; 

    def map between environment and membrane for 
        vars V and V; 
        vars t and t;  
    enddef; 
    def map between membrane and Na_channel for 
        vars V and V; 
        vars t and t; 
        vars i_Na and i_Na; 
    enddef; 
    def map between membrane and K_channel for 
        vars V and V; 
        vars t and t; 
        vars i_K and i_K;  
    enddef; 
    def map between membrane and L_channel for 
        vars V and V; 
        vars i_L and i_L; 
    enddef; 

    def comp membrane as 
        var V: millivolt {pub: in, priv: out}; 
        var t: millisec {pub: in, priv: out}; 
        var i_Na: microA_per_cm2 {pub: out, priv: in}; 
        var i_K: microA_per_cm2 {pub: out, priv: in}; 
        var i_L: microA_per_cm2 {pub: out, priv: in}; 
        var Cm: microF_per_cm2 {init: 1}; 
        var i_Stim: microA_per_cm2; 
        var i_Tot: microA_per_cm2; 

        i_Stim = sel 
            case (t >= 1{millisec}) and (t <= 1.2{millisec}): 
                100{microA_per_cm2}; 
            otherwise: 
                0{microA_per_cm2}; 
        endsel; 

        i_Tot = i_Stim + i_Na + i_K + i_L; 
        ode(V,t) = -i_Tot/Cm; 
     enddef; 

enddef; 

Imports 

Units 

Groups 

Environment component 

Mappings 

Membrane component 
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Note that the only units that need to be defined for this top level HH model are the ones explicitly 
required for the membrane component. All the other units, required for the various imported sub-
models, are imported along with the imported components.  

The results generated by the HH model are shown in Figure 23.  

 
 
Figure 23. Results from OpenCOR for the Hodgkin Huxley (HH) CellML model. The top panel shows the 
generated action potential. Note that the stimulus current is not really needed as the background outward 
leakage current is enough to drive the membrane potential up to the threshold for sodium channel opening.  
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Important note 

It is often convenient to have the sub-models – in this case the sodium_ion_channel.cellml model, 
the potassium_ion_channel.cellml model and the leakage_ion_channel.cellml model - loaded into 
OpenCOR at the same time as the high level model (HH.cellml), as shown in Figure 24. If you make 
changes to a model in the CellML text view, you must save the file (CTRL-S) before running a new 
simulation since the simulator works with the saved model. Furthermore, a change to a sub-model 
will only affect the high level model which imports it if you also save the high level model (or use the 
Reload option under the File menu).   

 

Figure 24. The HH.cellml model and its three sub-models are available under separate tabs in OpenCOR. 

 

References 

1. Cuellar AA, Lloyd CM, Nielsen PF, Halstead MDB, Bullivant DP, Nickerson DP, Hunter PJ.   
An overview of CellML 1.1, a biological model description language. SIMULATION: Transactions 
of the Society for Modeling and Simulation, 79(12):740-747, 2003 

2. Lloyd, C.M., Lawson, J.R., Hunter, P.J. and Nielsen, P.F. The CellML Model Repository. 
Bioinformatics, 24, 2122-2123, 2008. 

3. Cooling, M., Hunter, P. and Crampin, E.J. Modeling biological modularity with CellML. IET 
Systems Biology. 2(2):73-79, 2008. 

4. See http://www.cellml.org/about/publications for a more extensive list of publications on 
CellML and OpenCOR.  

5. Hodgkin, A.L. and Huxley, A.F. A quantitative description of membrane current and its 
application to conduction and excitation in nerve. Journal of Physiology, 117, 500-544, 1952. 
PubMed ID: 12991237 

 

http://www.cellml.org/about/publications
http://www.ncbi.nlm.nih.gov/entrez/query.fcgi?db=pubmed&cmd=Retrieve&dopt=AbstractPlus&list_uids=12991237&query_hl=1&itool=pubmed_docsum

